DUQUESNE UNIVERSITY SCHOOL OF LAW PRESENTS

Third Colonial Frontier

LEGAL WRITING CONFERENCE

TECHNOLOGY AND THE TEACHING OF LEGAL RESEARCH AND WRITING

March 16, 2013

sponsored by Wolters Kluwer

with additional support from LexisNexis

WESTLAW
Getting Your Points Across: Effective, Efficient, and Entertaining Critiques of Student Papers

Jan M. Levine
Duquesne University School of Law
March 16, 2013
Using Inserted Comments in MS Word 2011 for Mac

- There is a very critical setting for the comment balloons to prevent crashes of the application and loss of your work.
- This is a work-around for an as-yet uncorrected bug in MS Word, and is very hard to find online (you won’t find the solution to the problem on Microsoft’s website or by contacting them).
From the Word menu, click on Preferences
<table>
<thead>
<tr>
<th>Authoring and Proofing Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
</tr>
<tr>
<td>View</td>
</tr>
<tr>
<td>Edit</td>
</tr>
<tr>
<td>Spelling and Grammar</td>
</tr>
<tr>
<td>AutoCorrect</td>
</tr>
<tr>
<td>Equations</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output and Sharing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
</tr>
<tr>
<td>Print</td>
</tr>
<tr>
<td>Compatibility</td>
</tr>
<tr>
<td>Track Changes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Personal Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Information</td>
</tr>
<tr>
<td>Security</td>
</tr>
<tr>
<td>Feedback</td>
</tr>
<tr>
<td>File Locations</td>
</tr>
<tr>
<td>Ribbon</td>
</tr>
</tbody>
</table>

In Preferences select Track Changes
UNCHECK this second box under Balloons to stop crashes of Word!
Using Inserted Comments in MS Word 2011 for Mac

- Very long comments open up in the Sidebar because they’re too large to fit into the regular Comment balloon, and the default font size for the Sidebar is very small.
- Most people don’t know how to change this, but the View/Zoom setting for the Sidebar can be set independently of the regular document and comment View/Zoom settings, so you can make the size of the Sidebar font match the size of the Comment font.
MEMORANDUM

TO: Professor Jan M. Levine
From: Brandon T. Ryan, LRW 54
Date: August 28, 2012
Re: Elaine Rogers; Possibility of Civil Suit for Negligence against Mark Scott for failure to disclose which lead to infection with the Human Immunodeficiency Virus.

Statement of Facts

Our client, Elaine Rogers, wants to know if she has a cause of action for negligence against Mark Scott, a former sexual partner. She claims that he failed to disclose as well as take proper precautions to prevent the spread of the Human Immunodeficiency Virus, [HIV] that leads to the painful incurable and possibly fatal Acquired Immunodeficiency Syndrome. Which Mr. Scott knew that he had prior to sexual contact, and knew that sexual contact with an infected person would lead to transmission of the virus.
Throughout your memo, if I added something, the addition will be in red. This means the text will appear in red on your screen, but it may be printed as gray, and will be hard to read off of your computer if you don’t print my critique in color. I will strike text by using a strikeout (the text will have a line through it); that means it should be cut. I will also highlight blocks of text: blocks of text linked to a comment will be in yellow or other colors. Highlighting in red points out errors in citation form.

Other symbols are noted in the chart on page 30 of the Course Materials.

Comments about citation should lead you to the ALWD Citation Manual and to the special supplement I prepared for the section. Other comments about style, punctuation, and grammar, direct you to look our reference book, Ray & Ramsfield, Legal Writing: Getting it Right and Getting it Written, and the U.S. Government Printing Office Style Manual; I have also included many of those relevant items in the special supplement I prepared.

Please remember that I have not commented on every possible item that might be less than ideal, or simply wrong. So if I left something unmarked, don’t assume it is perfect! I may see things on the rewrite that did not get my attention on the first draft, or which are later worth the time to address and resolve.

Please bring printed documents to our conference; that is the easiest way for both of us to look at the materials. Come to the conference prepared, with questions; revise some parts of the memo to reflect or incorporate my comments. I can’t go over the whole memo in the half-hour conference, but I can look at enough to make sure you’re on track and understand my

Rogers, wants to know if she has a cause of ainst Mark Scott, a former sexual partner. She disclose as well as take proper precautions the Human Immunodeficiency Virus, [HIV] that urable and possibly fatal Acquired e. Which Mr. Scott knew that he had prior to that sexual contact with an infected person on of the virus.

Comment [1]: Throughout your memo, if I added something, the addition will be in red. This means the text will appear in red on your screen, but it may be printed as gray, and will be hard to read off of your computer if you don’t print my critique in color. I will strike text by using a strikeout (the text will have a line through it); that means it should be cut. I will also highlight blocks of text: blocks of text linked to a comment will be in yellow or other colors. Highlighting in red points out errors in citation form. Other symbols are noted in the chart on page 30 of the Course Materials.

Comment [2]: Please align all the items in the headings per the samples in the Course.

Comment [3]: This is a paper that demonstrates many of the common

Comment [4]: Good work here. Another example could be "negligence cause of"

Comment [5]: These section titles are boldfaced in the template and sample
Customizing MS Word

- Before you start customizing MS Word, or make any additional changes to MS Word in the future, always make sure you can restore the application to the state it was in before you began making changes.

- While you can always start over fresh, you want to know how you can restore customizations you’ve already made without wiping everything out and reverting to a pristine original installation of the application.
Customizing MS Word

- First, we’ll be modifying a key file, titled “Template.dotm” to customize MS Word.
- Word 2011 for Mac and Word for Windows (since 2007) both use the same kind of Template file, so files and Templates made for one operating system work just fine on the other, in the same way that .doc and .docx files can be opened and edited across platforms.
- But Word 2011 for Mac is far more customizable than the Windows version of Word has been since the introduction of the Ribbon.
What’s a Template?

- It’s a master file that contains your document Styles and other settings to format a new document.
- It contains your Toolbars and Menus.
- It contains your custom Word Macros written in the Visual Basic programming language.
- And it contains your AutoText entries.
- But in OS X Lion and OS X Mountain Lion (and also in Windows installations of MS Word) the file is hidden from your view, along with other system files, in the user’s Library folder.
Unhide the Library Folder, the (Temporary) Apple Way

- With either the desktop or a Finder window as the front most application, hold down the option key and select the Go menu.
- The Library folder will be listed as one of the items in the Go menu.
- Select Library, and a Finder window will open showing the contents of the Library folder.
- If you close the Library folder's Finder window, the folder will once again be hidden from view.
Finder Menu - Go - Option
From the Library folder, go to:
/Users/{USERNAME}/Library/Application Support/Microsoft/Office/User Templates

This hidden folder contains the "Default Templates" for all MS Office applications, /Users/{USERNAME}/Library/Application Support/Microsoft/Office/User Templates
Open that Finder window, and you’ll see a file named “Normal.dotm” in the folder.
Make the Hidden Library Folder Visible Permanently

- Apple hides the Library folder in OS X Mountain Lion by setting a file system flag associated with the folder. Any folder on your Mac can have its visibility flag turned on or off; Apple just chose to set the Library folder's visibility flag to the off state. To reset the visibility flag, do the following:
  - Launch Terminal, located at /Applications/Utilities.
Launch the Terminal application, which is located in the Applications/Utilities folder.
Enter the following command at the Terminal prompt:

```
chflags nohidden ~/Library
```

You can copy that text and paste it at the location of the cursor, or just type the text.

Then press the Enter/Return key.
Once the command is executed, you can quit Terminal from the Menu.

The Library folder will now be visible in the Finder.

Should you ever wish to set the Library folder back to its default hidden state, simply launch Terminal and issue the following Terminal command:

```
chflags hidden ~/Library
```
Now open a Finder window and go to:
/Users/{USERNAME}/Library/Application Support/Microsoft/Office/User Templates
Open that folder and you’ll see a file named “Normal.dotm” in the folder.
Make a backup copy of your Normal.dotm Template file

- Option-Click and drag the file to another location such as the Desktop, or even within the same folder, then release, making a copy.
- Or right-click and choose Duplicate from the choices that appear in the on-screen menu.
- This is added insurance, beyond what you have from Apple’s automated Time Machine backup application or any other backup system you use.
- If you ever delete the Normal.dotm Template file, an original unmodified Template will be recreated by MS Word when you restart Word, but it will be missing any of your customizations.

- But you can restore the customizations you made to your Template by renaming the backup copy Normal.dotm and replacing whatever Normal.dotm file is in the folder.
I keep copies of my Templates, Toolbars, and AutoCorrect entries in the Microsoft User folder within the Documents folder.
I put a shortcut to the hidden Templates folder within the Backups of Templates folder.
And I put a shortcut to the Backup Templates folder within that hidden User Templates folder.
You can customize the default Template yourself, or you can copy another person’s customizations

- I’ll explain how to do both. But first, I will show you how to copy my custom critiquing Toolbars and Macros.
- Word 2011 for Mac makes this easy, with a tool called the “Word Organizer.” Word for Windows does NOT have this tool.
You can adapt my custom toolbars, buttons, & macros

- I copied my Template for your use.
- The file is titled “Jan Levine's Template.dotm” and it’s on the flash drive distributed in the session, along with other materials.
- You may download it from the CloudApp URL at http://cl.ly/0g3C3G1f2X25
- Or you may download it from this Conference’s webpage, at http://www.duq.edu/academics/schools/law/academic-programs/legal-research-and-writing-program/legal-writing-conference-2013
Copy that file to your own non-default custom Template folder, which is found in a different location than the default Template, at:

/Users/{USERNAME}/Library/Application Support/Microsoft/Office/User Templates/My Templates

You can always copy things from my Template in the future if you want to make changes to your own Template.
- We want to open “Jan Levine’s Template.dotm” so you can copy the Toolbars and Macros.
- You could just double-click on the Template file from your desktop, or browse to it in Word using the Open menu command, which will instantly open the Template.
- But knowing how to store and open Templates is a good idea anyway, so let’s do it that way.
From the Word Menu, click on File, then New from Template, which will open the Word Document Gallery window.
You may see a warning window appear. If so, just click on the button Enable Macros.
Now you will see the Critiquing Toolbar appear.
Now you can copy my custom Toolbars and all of my custom Macros to your own default Template.
Word 2011 for Mac makes this incredibly easy, with a tool called the “Word Organizer” available from the Format Menu and the Style command.

Word for Windows does NOT have this tool, so those users have to create Macros individually.
Click on the Organizer button
And you'll open the Organizer tool
First we’ll copy all of the custom Macros, which are in the Macro Project Item entry, over to your Normal.dotm Template.

Then we’ll copy the three custom Toolbars.

Each of those includes simple custom Toolbar buttons I “drew and painted” using simple image editing applications to match the Microsoft colors used for the standard highlighting and text colors.

But today’s session won’t explain how to create the simple images for Toolbar buttons.
Copy the Macros from my Template to yours
Copy Toolbars from my Template to yours
Close the Organizer tool and then close MS Word.
You may get a prompt asking if you want to save the changes made to your Template; if so, click "yes" to accept the changes.
Then re-open MS Word.
Next, go to the View menu to select one or more of the new Toolbars.
Next, go to the Tools menu, click on Macros, and you should see all of the new Macros ready to run, to be edited, or be deleted.
The Custom Macros can now be run from the Tools Menu, by clicking on Macro and opening the list of Macros.
Critiquing Macro #1

- Extracting Comments to another document.
- Here’s a typical document with many comments.
Here is the result of running the Macro: a separate document with a chart showing easy-to-read comments linked to the relevant in-document text.

<table>
<thead>
<tr>
<th>Page</th>
<th>Comment scope</th>
<th>Comment text</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>The same court later applies the analytical rule from B.N. in Faya underscoring the duty a person has to disclose their Human Immunodeficiency Virus (HIV) infection when there is a chance of infecting others with the disease.</td>
<td>New paragraph for new case. That’s the start of the new paragraph.</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>knew he was infected</td>
<td>Again, he had to more than that! And he did.</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>his infection from a news article</td>
<td>He wasn’t infected from a news article! REVISE. And he wasn’t infected by the article at the time of his death!</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>You need pinpoint page citations for all the points you make in this paragraph.</td>
<td></td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>However,</td>
<td>New paragraph.</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>to take steps</td>
<td>He did. They jut weren’t enough.</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>disclose</td>
<td>When discussing the case, try to use the concept of informed consent, as the court did.</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>one’s</td>
<td>“One’s” is wrong. HIS would be better.</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>recognized the foreseeability</td>
<td>This is too vague. The facts showed that the surgeon KNEW this was possible, and the consequences of infection.</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>are</td>
<td>Past tense, not present.</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>Pinpoint page citations needed for the whole paragraph. Explain what the barrier techniques were.</td>
<td></td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>a person has a duty to disclose their</td>
<td>You need the singular form here, not the plural. Or the reverse. Not mixed.</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>6</td>
<td>the necessary precautions</td>
<td>I thought you said a condom wasn’t sufficient?</td>
<td>Jan M. Levine</td>
</tr>
<tr>
<td>7</td>
<td>Consequently, condom use is irrelevant, because a condom is similar to the surgical barrier techniques addressed in Fava.</td>
<td>Pinpoint page citation needed, with a signal. But what you just said above this is confusing! What other “prevention” is possible?</td>
<td>Jan M. Levine</td>
</tr>
</tbody>
</table>
Critiquing Macro #2

- Extracting TrackChanges to another document.
- Here’s a one-sentence document with the Tracked Change showing colored red and underscored.

```
After you use the full names of the disease, virus, etc., please use [brackets] or (parentheses) for the acronyms (such as AIDS, for Acquired Immune Deficiency Syndrome) or abbreviations (such as HIV); in addition, please capitalize the appropriate letters in the names.
```
This is the result of running the Macro: a separate document with the changes shown in an easy-to-read format.
More Custom Macros

- Save and copy an open file to two locations at once (such as your hard drive and a backup on a USB flash drive or another external drive).
- A set for Highlighting – all available standard Microsoft Office colors.
- A set for Coloring Text – all available standard Microsoft Office colors.
More Custom Macros

- Change from automatic numbers to normal numbers when copying a numbered list to a new document.
- Print numbered copies of a document.
- Extract all the AutoCorrect entries into a document.
The Mac’s Unix-based file & folder syntax uses colons instead of slashes.

So when you use a Visual Basic macro written for Windows on a Mac, and a file location is specified, you have to change a location such as "C:\Documents\Book\Chapters\” to the Mac equivalent "HardDrive:Users:MACOSUserName:Documents:Book:Chapters:”

Anyway, you will have to edit the Macro to save a duplicate copy to match the name of your own USB flash drive or other external drive.
Sources for Macros

- There are many websites and usergroups that share custom Macros.
- There is a list of sources at the end of the presentation.
- The source for most of the Macros I’ve given you is DocTools.com
Macros

VBA macros and code snippets for Microsoft Word

Below you will find VBA macros and code snippets related to Microsoft Word.

More VBA macros and code snippets will be added as time permits.

Some of the macros or code snippets may first have been created as part of
my answers to users who have posted questions to Microsoft Word
newsgroups. The versions included here may, however, be revised
compared to my newsgroup answers.

Please note that all VBA macros, code snippets and other information are
provided “as is” and without obligation. See also terms of use.

How to install the macros?

▸ READ INTRO Read further introduction to macros and code snippets

Macro – Add screen tips to text in Microsoft Word

Many users want to be able to make small screen tips in Word that work
like the screen tips known from Websites, i.e. small boxes with
information that appear when you hover the mouse over a text like
here. For example, such screen tips may be used to show definitions of
terms. Word has no functionality specifically for that but you can make use
of the hyperlink functionality and obtain something similar. You can
create such “screen tips hyperlinks” manually. However, this includes a
number of steps: You must select text, add a bookmark with an appropriate
name, create a hyperlink and enter the screen tip text, and format the text.
Here you will find a set of macros that automate the process. One macro
lets you add screen tips hyperlinks in a structured way and another one lets
you easily remove a screen tip hyperlink again if you wish.

▸ READ TIP Macro – Add screen tips to text in Microsoft Word

Macro – keep with next if colon at end of paragraph

You may want any paragraph that ends with a colon to always be on the
Toolbars

- In my Template I have modified the standard Word default Toolbars and Menus, created three custom Toolbars, and added corresponding Menu entries for some of the Macros.

![Image of custom Word toolbars with custom buttons representing custom macros]
Toolbars can be created, deleted, edited, resized, or docked.

These buttons were selected from all of the available standard Word tools, or were created to operate custom macros.
Right-click anywhere on a Toolbar and then select Customize Toolbars and Menus from the resulting menu.
You can select which Toolbar you want to work with, and which ones to show on screen.
Drag a command into a toolbar or menu bar.

You can drag any Command from any Menu category to a Toolbar.
In the Command Categories, select Macros, and you'll see all the new Custom Macros.
You can create a Toolbar button to run a Macro directly from your Standard Toolbar, or from any Toolbar you choose (even a new one you create).
You can also create a custom Menu entry to run a Macro by dragging a Macro to a location in the Menu bar.
This is the way the Menu looks when you are customizing it, so drag the Macro to one of these Menu lists, not the one on the very top of the screen.
 Macros have a standard name format and a standard button image, but you can change the name by double-clicking on the dragged Command and then clicking within the resulting Properties field for the name.

 You can change the button image from a small number of Microsoft-supplied buttons (until you learn how to create your own custom button images).
AutoCorrect

- This is the tool you can use to have Word automatically “replace” words or keystroke combinations “with” expanded and formatted text.
- This works just like spelling corrections you or Microsoft set to happen automatically, or like a “search and replace” from the QuickSearch bar.
- In a document, type and format the character string you want to be stored as an AutoCorrect entry, then open Preferences from Word’s Menu, and type in the characters you want to trigger the replacement.
Open Word Preferences from the Menu and select AutoCorrect.
Expand character string to a phrase
AutoCorrect: English (US)

- Automatically correct spelling and formatting as you type
  - Show AutoCorrect smart button
    - Correct Two Initial CAPitals
    - Capitalize first letter of sentences
    - Capitalize names of days
    - Capitalize first letter of table cells

- Replace text as you type
  - Replace: Tarasoff
  - With: Tarasoff

- Automatically use suggestions from the spelling checker

Description of preference

AutoCorrect
Use AutoCorrect to correct text and formatting as you type.
ClipMenu

- This is a free OS X clipboard expander works across all OS X applications that use copy/paste.
- You can copy and paste images or text.
- You can work with plain text or styled text, edit snippets, and manipulate text case and styling while pasting.
- You can create individual Snippets and Snippet Collections for critiquing different assignments.
- And you can create Snippets for other uses.
ClipMenu: A clipboard manager for Mac OS X

Clipboard History
ClipMenu can manage clipboard history. You can record 8 clipboard types, from plain text to image.

To paste a recorded item, you just pop up menu by invoking the shortcut key, and select a menu item from the menu.

Snippet
You can also register texts you frequently use, like e-mail addresses, user IDs and so on, as snippets. You can paste these snippets from the menu, too.
This is a very good beginning to your legal writing career! You write in your own voice, and seem to be very comfortable with the writing needed for this course and legal analysis in general. There was very little here for me to point out, and only a small bit of confusion. You’re off to an impressive start! Thanks for doing such a good job.
This is a demo of ClipMenu.
This is a demo of ClipMenu.

Comment [1]: This is a very good beginning to your legal writing career! You write in your own voice, and seem to be very comfortable with the writing needed for this course and legal analysis in general. There was very little here for me to point out, and only a small bit of confusion. You’re off to an impressive start! Thanks for doing such a good job.
TypeIt4Me

- Works across all OS X applications.
- You can trigger the pasting of typing of blocks of text (plain text or formatted) or pasting of images by typing short strings of characters on the keyboard, or by selecting the action using two mouse clicks on an item from a drop-down list out of the Menu Bar.
- You can create Clipping sets, any one of which can be open at a time.
TypeIt4Me running from the Menu Bar using special Clipping Set, triggered by the mouse cursor.

This shows the text that can be automatically typed into a document or any field that accepts text, by selecting it with the cursor or by typing the string "GPOcapitals"
U.S. GOVERNMENT PRINTING OFFICE STYLE MANUAL

Abbreviations

9.9. United States must be spelled out when appearing in a sentence containing the name of another country. The abbreviation **U.S. will be used when preceding** the word **Government or the name of a Government organization**, except in formal writing (treaties, Executive orders, proclamations, etc.); congressional bills; legal citations and courtwork; and covers and title pages.

- U.S. Government
- U.S. Congress
- U.S. Department of Health and Human Services
- U.S. district court
- U.S. Supreme Court
- **but** Supreme Court of the United States
- U.S. Army
- **but** Army of the United States
- U.S. monitor Nantucket
- U.S.-NATO assistance
- U.S. Government efforts to control inflation must be successful if the United States is to have a stable economy.
- **but** British, French, and United States Governments; United States-British talks
This $20 application lets you easily record audio comments on student papers, using your laptop’s built-in microphone or an external higher-quality microphone.

The application is built around the way we used to use a cassette recorder.

You can E-mail the audio comments directly to your students from within the TapeDeck application, using your default e-mail application.

You can color-code and organize the resulting audio comment files.
TapeDeck

TapeDeck is a powerful and fun audio recorder for OS X. It's just like your old analog tape recorder, only better. A lot better.

You're never more than a single mouse click (or keystroke) away from making a new recording....

What's New in Version 1.5.2

- You can once again drag MPEG-4 audio files into the list of tapes.
Tape that was just recorded or is being played back.
Three quality setting options for HQ (high quality), MQ (medium quality), and LQ (low quality), trading off audio quality and file size.
Individual "tapes" which represent separate files, named and color-coded for student and document.
TapeDeck Recording: Nicholas Yovich - QPs and PHs

To: [Redacted]
Cc: [Redacted]
Subject: TapeDeck Recording: Nicholas Yovich - QPs and PHs

From: Jan Levine <levine@duq.edu>

Recorded with TapeDeck
http://tapedeckapp.com

[2021-03-25 64.8 MB]
Websites about MS Word

Websites about MS Word

- http://www.microsoft.com/mac
- http://www.microsoft.com/mac/support
- http://www.msofficeforums.com/
- http://www.officeformachelp.com/
- http://www.thedoctools.com/
Websites about Mac Apps

- http://mac.appstorm.net/
- http://mac.tutsplus.com/
- http://osxdaily.com/
- http://reviews.cnet.com/macfixit/
- http://www.addictivetips.com/category/mac-os/
- http://www.cultofmac.com/
- http://www.maclife.com/
- http://www.macrumors.com/
- http://www.macupdate.com/
- http://www.macworld.com/
Questions?